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Setup Instructions

1. If a *Hands-On Exercises’ folder has already been extracted to you desktop,
delete it to make sure you aren’t using a previous users files.

2. Extract the contents of ‘Hands-On Exercises.Zip’ onto your desktop.

3. The files necessary to complete the exercises will be located in the “‘Hands-
On Exercises’ directory on your desktop.






Exercise 1l Enhanced Project Window

Goal

The new functionality available within the Project Explorer is designed to help manage large
application development by introducing features that prevent cross-linking files and enable
advanced control of project hierarchies and dependencies.

Scenario

Top-level Vs can accidentally call the incorrect sub-VI-. Applications that are saved in multiple
locations as a result of archiving, backup up or division of work are the most common culprit and
can lead to use of incorrect code and broken applications.

Description

If used correctly, the tools provided in the enhanced Project in LabVIEW 8.5 can reduce the
chance of incorrect linking and also helps resolve conflicts if they do occur.

Concepts Covered

What scenarios can lead to cross-linked files?

How can you determine the location of files on a disk?

Is there a way to move or rename files from within the Project explorer?

How does the dependencies section distinguish between user subVIs and LabVIEW subVIs?
What does LabVIEW do when it detects a conflict and what methods can be used to resolve it?

What additional functionality has been added to the project?



Part 1: Conflicts and Cross-Linking

1) Exploring a Project With Conflicts

a) Open Hands-On Exercises\File and Project Management\Cross-

Linking Exercises.lvproj

b) Expand the folders to see the various VIs that LabVIEW indicates have potential

d)

conflicts. These are highlighted with a yellow exclamation mark next to the name.

b Project Explorer - Cross-Linking Exe... E]@

File Edit “iew Project Operate Tools ‘Window  Help

| Sl « | 65 ok | B~

Ikems | Files

= ’Tg;l, Project: Cross-Linking Exercises. lvproj
= B My Compliker
= Sine Wave
g{"?ﬁ- Generake Signal.vi [Conflict]
= [ Sguare Wave
g? Generate Signal.vi [Conflict]
= [ File 1o
‘. [miE Log ta File.vi [Conflict]
i!i.]» Create and Save Signal,vi
= "= Dependencies
- wildib
gzﬁi Log o File.wi [Conflict]
(4] leanbes.di
- W Build Specifications

Two different conflicts exist

i) Multiple files with the name Generate Signals.vi are referenced in the project

i) A top-level VI is calling a subVI outside the project, Log to File.vi, which
shares a name with a file already contained in the project

Double click Generate Signal.vi inthe Sine Wave folder

Open the block diagram and observe that this VI generates a Sine Wave

Close Generate Signal.vi



2)

3)

g) Double click Generate Signal.vi inthe Square Wave Folder

h) Open the block diagram and observe that this V1 is different because it generates a

Square Wave

i) Close Generate Signal.vi

Examine the new column for viewing the path of a file on the computer’s hard disk. The first

step when attempting to resolve conflicts that exist as a result of cross linking is often to view

the file paths of the files referenced in the project.

a) Turn on Show Item Paths in the Project menu to see the paths of the files by selecting

Project >> Show Item Paths

b Project Explorer - Cross-Linking Exercises.lvproj *

File Edit View Project

o

: Eilter Yiew

= :J F| Show Item Paths
g File Information

: Resalve Conflicts...

Operate  Tools  wWindow Help

ST [denw Project v
S . =08 Y | 5]
Open Praject...
Items | Files || Save Project
Project Items Close Project Paths
= &l Project:  add To Project Pl C\ExercisesiLabYIEW 8.5\File and Project ManagementiCross-Linking Exercise:

fl

rft]

Properties |
7% Log to File.vi [Conflict]
- (&) heanlys.dl

Build Specifications

C\Exercises\LabYIEW 5.5\Filz and Project Managementiwiorking Directory 3ine
C\Exercises\LabYIEW 5.5VFil= and Project Managementiwhorking Directoryl3gu
C\Exercises\LabYIEwW 5.5\Fil= and Project Managementiwhorking Directory\File

C\Exercises\LabYIEwW 5.5VFil= and Project Managementiwhorking Directory Cre.

C\Exercises\LabYIEW 5.5\Fil= and Project ManagementiBackup DireckoryFile [
C:\Program Files\Mational InstrumentsiLabWIEW 8.5\ resourcetlvankys. di

b) This redesigned interface clearly shows where files are located in a second column.

If one of the two VIs isn’t used anywhere else in the application, than the conflict can be

easily resolved by removing the unused code. However, it is still important to consider

whether or not the code will eventually be used.

a) Ensure that you are still in the Items view

b) Right click on the first Generate Signal.wvi and select Find » Callers
c) LabVIEW will highlight any VIs that call as a subVI

d) Repeat this process for the second Generate Signal.vi



€)

f)

The second copy is not called by any VIs; however, it may be inadvisable to delete since
it appears to have different functionality

The appropriate action would be to rename one or both files

4) Manually renaming files is a frequent solution when cross-linking occurs. When renaming a

file it is important to ensure that any references to it are preserved by performing this

operation from within the LabVIEW project window.

a)

Click on the Files Tab to see the actual hierarchy of files on your computer’s hard drive.

&3 Project Explorer - Cross-Linking Exercises.lvproj <
File Edit Yew Project Operate Tools Window Help

P * = -
[hedglsbox[[erim- e alz s o]

ItemQ Files )

Project Items Paths

= i cy

12+ Exercises C:\Exercises
=) | LabVIEW 8.5 C\Exercizes\LabyIEW &.5
(477 File and Project Management C\Exercises\LabYIEW &.5\File and Project Management
-_;u Backup Directary C\Exercizes\LabYIEW &.5\File and Project ManagementiBackup Directory
(£ File IO C\Exercises\LabYIEW &.5\File and Project Management\Backup DireckoryiFile 10
.;? Log ta File, vi C\Exercizes\LabYIEW &.5\File and Project ManagementiBackup DirectoryiFile I0iLog ta File, vi

‘orking Direckary C:\Exercises\LabYIEW 8.5\File and Project ManagementiWarking Directary

7 File IO C\Exercizes\LabYIEW &.5\File and Project ManagementiWwiorking DirectoryFile IO

'g'i\ Laog to File.vi C:\Exercises\LabYIEW 8.5\File and Project ManagementiWarking DirectoryiFile I0Lag ta File.vi

Sine Wawve C\Exercises\LabyIEW &.5\File and Project Managementiwiarking Directorylsine Wave

- g?\ Generate Signal. vi C:\Exercises\LabYIEW 8.5\File and Project ManagementiWarking DirectorylSine WaveGenerate Signal.vi

Square Wave C\Exercises\LabyIEW 8.51File and Project Management!wiorking Directory)Square Wave

§x Generate Signal, vi C:\Exercises\LabYIEW 8.5\File and Project Management)Warking DirectarylSquare Wave\Generate Signal.vi
|, Create and Save Signal.wi CiiExercisesiLab¥IEW 8 .5\File and Project Managementiwiorking Directory|Create and Save Signal. vi

@3 Cross-Linking Exercises.vproj C:\Exercises\LabYIEW &.5\File and Project Management\Cross-Linking Exercises. lvpraj

-7 Program Files C:\Program Files

Navigate to the locations of both files named Generate Signals.vi

Right click on Generate Signals.vi inthe Sine Wave folder and select
Rename...

Type the name Generate Sine Wave.vi and click OK

LabVIEW prompts you to save the changes made to the calling VI, Create and

Save Signal.vi, inorder to preserve links. Click Save.

13 Save changes before closing?

Create and 5ave Signal.vi has unsaved changes.

Create and Save Signal.vi is about to leave memory. Iks unsaved
changes will be lost.

List unsaved changes. ..

| Save changes now

L Remove from memary without saving

| Cancel | Pragrammatic close cannok be cancelled




f) Rightclick on Generate Signals.vi inthe Square Wave folder and select
Rename...
g) Type the name Generate Square Wave.vi and click OK

h) Click Save when the dialog appears.

+;__'I Backup Directory [

—_‘,- Working Direckorsy o

+[) File 10 o

—_; Sine Wave o

.;2- Sine Wave - Generate Signal, vi i

—_} Square Wave ]|

5 gg_ Square Wave - Generate Signal.vi i)

éﬂ, Create and Save Signal.wi (ofl|

@;_'3, Cross-Linking Exercises. lvproj i

4 Program Files oo

i) Save the modifications to the project by selecting File >> Save

5) Explore advanced methods for automatically detecting and resolving cross-linking.

a) Create and Save Signal.vi references a file that is not currently in the project,
Log to File.vi, which we can determine due to the appearance of the file under
dependencies. However, a different copy of this file exists within the project within the
File 10 folder.

b) Expand the dependencies and observe that the second copy of Log to File.viis

listed here since it is called by a file within the Project

b Project Explorer - Cross-Linking [

File Edit View Project Operate Tools
de =] 1y =
Rel=1 N e! Il &

Items | Files

= @g, Praject: Cross-Linking Exercises lvp
2 B My Computer

& [ Sine wave

=: [ Souare Wave

& 11
& [l Log ko File.vi [Conflict]

_-:!q-! Dependencies

i L

" Log to File wi [Conflict] I
1 arlye

10



c) The Dependencies section of the project has been modified in LabVIEW 8.5 so that it

separates user created subVIs from VIs within vi.lib. Now only the contents of libraries

referenced within a project will appear within the dependencies section.

d) LabVIEW will prompt you to resolve conflicts if you select any of the following

i) Click the Resolve Conflicts icon on the top menu

Wb | @ e{?}
p—

i) Attempt to open a top level VI that is calling a subVI that has a conflict

iii) Right click a VI with a conflict and select Resolve Conflcits

e) Click the yellow icon on the toolbar to resolve conflicts (Option i)

f) The following dialog prompt appears, enumerating all of the conflicts that exist within

the Project

{3 Resolve Project Conflicts in “Cross-Linking Exercises.lvproj”

BEx

itern(s) that need to be updated.

Corflicts
= Log to File,vi

Corflicting items are grouped by name. For each group, select which path ko use, LabYIEW wil
1 remave the ather canflicting item{s) From the project tree and prompt you to save any referencing

CHiExercisesiLabWIENW & 5\File and Project ManagementiBackup Directory|File I0\Log to File. i
CH\ExercicesiLabVIEW . 5\File and Project Managementiorking DirectoryiFile I0iLog ta File, i

|

Compars

| [ Use Selected Ikem

Details for Selected Tkemis)

1| | Directory'File I0%Log to File.vi
ualfied Mame: Log to File.wi
File created: 8/2/2007 9:28:50 AM
File madified: 8/1,/2007 1:08:59 PM

Referencing Items
Status  Path

Path: C:\Exercises'Lab¥IEW 8.5'File and Project Management',Backup Pe

QF  C\ExercisesiLabvIEw §.5\File and Project Management|working DirectoryiCreate al

-~

e

g) Close this dialog without selecting an item

h) Open Create and Save Signal.vi (Option ii)

11
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1) The following dialog prompt appears, asking you to select which subVI the caller will

reference

13 Resolve Load Conflict @

j Create and Save Signal.vi refers to Log to File.wi, but there are multiple items named Log to File.vi

in Cross-Linking Exercises.lvproj or its dependencies.

Select the item to load From the lisk below,

Conflicting Items

[ Path

= CiiExercisesiLabVIEW 8 51Fle and Project ManagementiBackup DirectoryiFile I0iLog ko f 8.5
CH\ExercisesiLabvIEW 8.5\File and Project Managementiworking DirectoryiFile IOlLog to 8.5

LabYIEW Yersion ||

|8 :_
Details for Selected Item

[ Path: C:\ExercisesLab¥IEW 8.5%File and Project Management',Backup Directory'File
'-.-;-k I0%Log to File.¥i

GQualified Name: Log to File.wi

File created: 8/2 /2007 9:26:50 AM

File modified: 8/1/2007 1:08:59 PM

=) Create and Save Signal.vi expects Log to File.vi at this path.

Load with Selected ]| Cancel ][ Help

j) Before you can view the VI you must select which of the two conflicting Log to
File.vi programs should be called by Create and Save Signal.vi
k) Select the VI from the Working Directory and click Load with Selected

Note: To determine which VI resides in the Working Directory you’ll need to examine the
file paths of the two copies of Log to File.vi. If the path names are longer than the
window allows you to see, hover over them with your mouse in order to display the rest of

the path.

I) A warning dialog will appear afterwards informing you that the subVI was switched to a

different location.



= Project Explorer - Cross-Linking Exercises. lvproj

S

File Edit Yiew Project Operate Tools ‘Window Help

[bed xDOX||SkH @,

I

Ttems | Files

Projeck Ikems

= J_,-;l, Project: Cross-Linking Exercises,lvproj

B My Computer
Sine Wave
l;g, Sine Wave - Generate Signal.vi
[ Sguare Wave
i gg, Square Wave - Generate Signal.vi
File IO
i;g, Log to File.wi
Create and Save Signal.vi

! Dependencies

[ vilib

lﬂ bvankys.di

“ . Buid Specifications

m) All conflicts should be resolved at this point

Note: Conflict resolution may not be possible using this dialog for VIs within folders set to
Auto-populate, which is discussed further in the next section. LabVIEW will not remove files

from an auto-populate folder since the folder is always a direct representation of the contents of

the hard drive. Resolution of conflicts within auto-populate folders may require manually

renaming or moving files.
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Part 2: Auto-Populate Project Folders

1)

14

Auto-Populate is a new mode for folders in LabVIEW 8.5 that simplifies the process of
organizing and sorting the contents of the Project. When Auto-Populate is turned on for a
specific folder, the contents of the folder reflect the hierarchy on disk. Folders that are set to
Auto-Populate are distinguished by a unique folder icon. [

a) Right click on the Sine Wave folder in the project and select Convert to Auto-

Populating Folder...

ﬂ.Pruject Explnrer - Cross-Linking Exercises.lvprnj o g@
File Edit Wew Project Operate Tools  Window  Help

S| xhoX]|8k| E- e

Items | Files |

Project Ikems
= :ng, Project: Cross-Linking Exercises, [vproj
= B My Computer

=8 e R , |
e [ ﬁl .
o[ Squ  Add >

. — =
£ - I;E»_ 5 Conwett bo Auto-populating Falder...
I EE-’ F'leé Find Project Tkems. ..

|_ Creé Converk to Library
'] | —

= 'a DEPi Expand All

.
® “J ! Collapse Al
L.Jg I .
- Euili Rermove From Project

Rename... Fz

b) Navigate to the Sine Wave folder located at Hands-On Exercises\File and
Project Management\Working Directory\Sine Wave

c) Click Current Folder

d) Observe that the folder icon changes to indicate that the folder is now set to Auto-
Populate

e) Click on the Files tab



Note: Any modifications to location of files contained within folders set to Auto-Populate
will immediately be reflected in the Items view. You cannot move files from within the

Items view, since this is no longer independent of actual file location.

f) Find the Sine Wave folder on your computer’s disk hierarchy within the Files View by

exploring the folders as shown below

g) Right click on the folder and select Explore

2 B My Computer
— [C) Sine Wave
P |l Genera
+ [ Sguare 'Ws
4 [ File IO
gﬂ, Create anc
+_'-f|:|_" Dependers
+% Build Sperci

= ﬁ_g;l, Project: Cross-Linking Exercises, [vproj

e

Explore...
Shows in Files Yie

#dd

Stop Auto-popula

h) Once the explorer opens, create a new text document, type the name DataFile.txt,

and save it to this location. In Windows you can do this by right clicking in the explorer

window and selecting New >> Text Document

i) Note that this file now appears in the project wi

ndow

i3 Project Explorer - Cross-Linking Exercises.lvproj

File Edit Wiew Projeck Operate

Tools Window Help

e xh o Xk E- o

Items | Files

[ Project Ikems

= B My Computer
= [ [Sine Wave

Erer

= [ File 10

L |l LogtoFile.vi

= I:Eg, Project: Cross-Linking Exercises. lvproj

ake Signal. vi

|_!§* Square \Wave - Generake Signal.vi

'—;.22 Create and Save Signal . vi
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Part 3: Additional Project Enhancements

1) You can now search the contents of the project by pressing CTRL+F or selecting Edit >>

Find Project Items

13 Find Project Items in "Cross-Linking Exercises.lvproj”

Twpe in kext ko search For:

sine

[] case sensitive
] Match whale word

D Regular expression

Search results: (Found & items in "Cross-Linking Exercises. lvproj™)

Marne Location in Project Path -~
[ﬁ' Sine Wave My ComputerSine Wave C\Exercises\LabWIEW 8.51File and Project Mana
[£] Data File. bt Ty Compuber/Sine Wave/Data File, bxt C\ExercisesiLabwIEW 3.51File and Project Mana
IEQ» 3ine Wave - @enerake Signal.v My Computer/Sine Wave/3ine Wave - Generake 5 C\Exercises\LabWIEW 3.54File and Project Mana
IEQ» 3ine Wavelform.vi Iy Computer/Dependenciesvi [ibiMI_MABase.lvlil C:\Program Files\Mational InstrumentsLabyTEw
l;’gl, Gaussian Modulated Sine Patte My Computer/Dependenciesvi. ibfMI_anLEase. v C:\Program FilesiMational InstrumentsiLabyIEw
|§:§1» General Gauss-Mod Sine, vi My Computer/Dependenciesvi.libMI_AALBase. vl C\Program Files\Mational InstrumentsiLabyTE W
|§:§1» Sine Patkern, i My Computer/Dependenciesvi.libMI_AALBase. vl C\Program Files\Mational InstrumentsiLabyTE W
IEQ» Sine Wave,vi My Computer/Dependenciesvi.libiMI_AALBase vl C\Program Files\Mational InstrurmentsiLabyYIEW
w
< >
[ Go Tao ] [ Close ] [ Help ]

2) You can now select File >> Save As and re-create the contents of an entire project and its

dependencies elsewhere on disk. This is only possible if no conflicts exist

3) Replace With
a) Right click on a VI inside the Project Window
b) Select ‘Replace With’ to swap a VI for another VI.
c) LabVIEW automatically adjusts linking

End of Exercise 1
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Exercise 2 VI Merge

Goal

Familiarize yourself with how to use VI Merge to automatically recombine changes made by
multiple developers to the same piece of graphical code and how to handle conflicting
modifications.

Scenario

Two different developers edit a shared VI at the same time. To continue making progress the
work from both developers needs to be combined into a single VI.

Description

VI Merge requires three copies of the VI in order to properly compare and merge the code.
Base VI — The original, un-modified code

Their VI — A copy of Base VI that has been modified

Your VI — A second copy of Base VI that has also been separately modified

VI Merge can be run interactively from within the development environment, or it can be called
externally as an executable. Either way, it must be supplied these three parameters to operate.

Concepts Covered

Will the original code run without modification?

What is the difference between the two saved copies of the original code?

How does VI Merge handle conflicting modifications?

What process would be necessary to accomplish the same goal without VI Merge?

How can this process be used to improve development cycle efficiency?

17



Part 1: Recombine Code

1) View Base VI.vi
a) Open Hands-On Exercises\VI Merge\Base.vi
b) View the block diagram

c) Note the broken run arrow and the broken wire

@ IE | 13pt Application Font - I| ;m‘E

BT "Basic Function Gererator” ¥ e

Frequency

Wwaveform Graph

ampllitude
;

d) Browse the two cases to observe that they are both currently empty

2) View the two modified versions, developerl.vi, and developer2.vi. These VIs are
effectively the result of distributing base.vi to two separate developers and asking them
to populate each case separately.

a) Open Hands-On Exercises\VI Merge\developerl.vi
b) Note that the amplitude control has been changed to a knob

c) View the block diagram

| "Basic Function Generakor” v

Basic Function Generakor.vi
=T ]

18



d) Note that the Sine Waveform case has been populated with code, but that the Basic
Function Generator case has not

e) Close the current VI

f) Open Hands-On Exercises\VI Merge\developer2.vi

g) Note that the amplitude control has been changed to a slider

h) View the block diagram

B ] "Sine Waveform”, Default k"5

Sine ‘Wavefarm, vi

i) Note that the Basic Function Generator case has been populated with code to generate a
sine wave, but that the Sine Waveform case has not
j) Close the current VI

3) Merge Modifications Together
a) On the main menu select Tools » VI Merge

i3 Getting Started
File Operate Tools Help

Measurement & Autarmation Explorer, ..

ﬂ l Instrumentation b
4

MathScripk Window. .,

.

New User Mame. ..

Bl Blank|  Conwert Build Script. ..
Source Control

T Ermpty
LLE Manager...

b) Enter the location of the appropriate pieces of code into the dialog as shown

19



13 Merge ¥is

s to Merge
Base VI C:\ExercisesiLabVIEW 8,511 Merge\base.vi
Their Y1 C:\ExercisesiLabVIEW 8.51VI Mergs\developer 1.vi
Your V1 C:\ExercisesiLabVIEW 8.5\V1 Merge'developer 2.vi

= Merge options

: Auko-resolve Block diagram cosmetic changes

[#]Frorit panel position/size changes [ Elock diagram position,size changes

| Merge ] [ Cancel ] [ Help

c) Make sure that the various Merge options are set as shown above
d) Click Merge

4) Merged Result
a) After running VI Merge, several windows will appear
b) Base VI, Their VI, and Your VI will be displayed on the left
c) The automatically merged VI will be shown on the top right of the screen
d) Note that the merged VI now has a working run arrow, indicating that there are no errors
and that code was successfully merged
e) The bottom right dialog displays all the mergers that were automatically performed
Note: Clicking on the listed mergers in the dialog will highlight the modification that were

made on the diagram of the VI.

5) Resolving Conflicts
a) The bottom right dialog will display any conflicts that LabVIEW could not automatically
perform. When navigating through these conflicts you have the option of selecting either
the modification from Your VI or from Their VI. If no option is selected, the original,

unchanged object from the base VI .vi remains.

20



[ﬂ lerge block diagrams }nl_ln(illetl Merged 1 Block Diagram * g@]

=IEE 7 B Ed
_ L2 B Untitlod Merged 1 Front Panel Q@l
e By ]5\3 Edt Wew Project Operate TInols window Help

ri:r./lelg-,re

3 Unresolved conflicting changets)
@ Front Panel - Numeric [a] Chaoss Theirs
= X Fronk Panel objects - ——

. Theirs Chonse Base:

controlfindicator kind
i X Fronk Panel objects

- Block Diagram objects

@ Block Diagram objects

- Block Diagram objects

/= X Block Diagram ohjects

S Theirs
© - Front Panel Termingl: data type
S Yours

Front Panel Terminal: data type

Show ol changes

[ showpetsi | [ optons | [ e || Hep |

b) In this example, a conflict exists between the modification to the amplitude control.
Developer 1 made it a know and developer 2 made it a slider; therefore, LabVIEW does
not know which modification to select.

c) Manually resolve this conflict by selecting the Knob control from Developerl.VI

d) Click Close and save the merged VI to Open Hands-0n Exercises\VI
Merge\Merged.VI

End of Exercise 2
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Exercise 3 In Place Element Structure

Optional Exercise

Goal

Familiarize yourself with how to use the In Place Element Structure to explicitly tell the
LabVIEW compiler not to allocate memory or copy data.

Scenario

Applications often modify an existing element in an array. An example of this might be an array
containing information about a list of people. Each person’s name, birthday, and children’s
names are included. The children’s names need to be converted into all capital letters and the
new string must replace the current string.

Description

The In-Place Element Structure will be used to minimize the number of copies that are made in
memory of the data array.

Concepts Covered

When is it pertinent to use the In Place Element Structure?

What palette is the In Place Element Structure located on?

Will the unbundled allow the user to select Birthday and Birthday.Day?

Why is a shift register included in this VI if the In Place Element Structure already tells the
compiler to replace the data?

22



Part 1: LabVIEW Data Memory Allocation

1) Examine memory usage without the In Place Element Structure

a) Open Hands-On Exercises\Memory Management\Memory.vi

= Memory.vi Block Diagram g@
File Edit ¥iew Project Operate Iools Window Help
OE b/ | | 130t Application Font v||:n'||:ﬁv|

-

People Ot
]|

People In E
[eat &

]

View the block diagram

Select Tools >> Profile >> Show Buffer Allocations.

Select Arrays and Clusters

Click Refresh to show black dots on the block diagram where the compiler will be
making a copy of the data in memory. Large, memory intensive applications often
require certain coding practices in order to minimize the number of copies made, such as

the use of the In Place Element structure.

3 e
Fle Edit View Frojert Operste Tooks Window Help —
u:u@E@ujr [ 130t Appication Font_ |~ |[ B ][ | ]
-~
Pebple People Out
7D frermeel i ]
am ST -0 -
7
7
.V.
< T 3]
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2) Use the In Place Element Structure to reduce the number of copies made
a) Delete the Index Array and the Replace Array Subset from the VI block diagram
b) Right-click on the block diagram to see the Functions Palette
c) Go to Programming >>Application Control >> Memory Control and select the In

Place Element Structure

-[::’] Funckions C{'Searcht
Programming 4
4 g *
o -
[os! e Cad
Structures Array Cluster, Class, ..
¥ = i 2
i
Mumeric More File IO Boolean
abic H I}:‘;:- » 4
[5= G:'
Skring Comparison Tiring
L B
T X
LA
k| _ZE;_ | <=1 Application Control
Dialog & User. .. Waveform Application ... Memory Control
3 M —oo by B e
fo’| W = [ & BT
ol 8 o *Q! o= 0= cl

Synchronization Graphics % So.,. Report Gerner... Open &pp Ref  Open VI Refe... Static WIRefe... Close Refere. .,

yision and Mation ' i @
Express B % %

Fawvarites Call By Refer... Property Mode  Inwvoke Mode Zall Chain

User Libraries EI

Select a vl...

Biomedical Applications To More Spec,.. To More Gen,.. Class Specifie... YI Server Ref. ..

Innns

FPad Inkerface b 2 Fra. § [ | |

O5C Madule -[::] Mermary Contraol |{I HF

Real-Time ematy Conkrol
H ':' =)

Statechart .:]—['I. [+

S

Flace Elem, Swap Yalues Always Copy  Reguesk Deall, .,

24



d) Place the structure on the block diagram around the unbundle and bundle

e) Right-click on the frame and select Add Array Index / Replace Elements

3 Memory.vi Block Diagram *

SEX]

File Edit Yew Project Operate Tools Window Help

[P & @{.E ba uﬁ| 13pt Application Font | ||I;mv |~ j

[
—
Visible Items
Help
H Description and Tip...
Feopls In § Set Breakpoint People Cut
[E= et [E i)
Memory Control Palette
o b o Auko Grow
Remove In Place Element Structure
Replace with While Loop
Add Array Index | Replace Elements
Add Unbundle § Bundle Elements
Add Waveform Unbundle [ Bundle Elements
Add Variant To [ From Element -
‘E' Add In Place In f Out Element
|
< &
f) Wire as shown in the diagram
13 Solution.vi Block Diagram * E]@
File Edit Yew Project Operate Tools Window Help
— — e 3
OIE I.ullﬁ’ oft | 13pk Application Fonk |+ ” ;mv” .u.vl 1
[a]
People In E People Cut
=Dt = b
Ta A} Eleososes ={ Children fapype——— 3
I
[v]
(2]

<
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3) Use Show Buffer Allocations to view the number of dots with the In Place Element Structure
a) Go to Tools >> Profile >>Show Buffer Allocations
b) Select Arrays and Clusters
c) Click Refresh to show the dots

13 Solution.vi Block Diagram

File Edit Wiew Eroje.ct Operate  Tools window Help i
¢>|{§}| @.@“.ullmuﬁ [ 130t Application Fort "]|!m']|7u:'] =4

People Cut
ke E]

Iy

n ...... ] TanAl

d) Note that the number of dots has been reduced by one and that the compiler is therefore

making one less copy in memory per iteration

End of Exercise 3
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Exercise 4 LabVIEW MathScript

Goal

Familiarize yourself with the new functionality of the MathScript Node in LabVIEW 8.5.

Scenario

A developer is utilizing the hybrid approach to programming in LabVIEW. He is writing a
program to generate two test signals, add some noise to these signals, and apply a moving-
average filter to remove the noise. With the MathScript Node, the developer is attempting to call
a User-Defined Function (UDF) but is running into errors in his LabVIEW diagram. In previous
versions of LabVIEW MathScript, error-checking was not performed until run-time. With
LabVIEW 8.5, the developer can now take advantage of edit-time error-checking within the
MathScript Node, as well as the LabVIEW probe to simplify the development process of
incorporating textual math into the graphical programming environment of LabVIEW.

Description
LabVIEW 8.5 adds a number of features for working with MathScript such as:

edit-time error-checking

in-node line numbers

probing

*.m file incorporation with the LabVIEW Project

These new features ease the process of incorporating textual math into LabVIEW. MathScript is
generally compatible with .m file script syntax, which is the syntax widely used by alternative
technical computing software. Such compatibility means that you can work with many
previously developed m-file scripts with those available in engineering textbooks or on websites
that distribute open-source m-file scripts.
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Part 1: Improved MathScript Error Checking

1) Set MathScript search path(s) in LabVIEW to include a User Defined Function (UDF)
a) Open Hands-On Exercises\MathScript\MathScript

28

Debugging\MathScript Debugging Project.lvproj
b) Double click MathScript Test.vi

c) Note the broken run arrow. Click on the List Errors button to display the error:

43 Error list g@

Items with errars
X Mathscript Test,wi ||

4]

1 errors and warnings Show Warnings O

Y ; T
i’Math:cripL Mode: A syntax or semartic error has occurred l! [

Dietails
Unknown symbal on line 7: add2num |

Close ] [ Show Error ] [ Help

d) LabVIEW recognizes that this is an unknown symbol because it does not match any
previously-defined variables, native MathScript functions, or loaded UDFs. The
unknown symbol error when calling a UDF tells us that the function is not located in a
MathScript Search Path. To fix the error, we need to add the directory of the .m file to
the MathScript Search Path(s)

e) In the project window, right click on My Computer and select Properties

Items | Files

= |T_g;1, Project: MathScript Debugging Project. lvpro
= B [My Compliter
= |l Mathserip  Mew »
+ :L‘.;-‘n_' Dependel ;14 N
%; Build Spet |
Export »
Import »

Arrange by p
Expand Al
Collapse all

Help...
Properties




f) Addthe Hands-On Exercises\MathScript\My Scripts to the Search
Path(s)
i) Highlight MathScript: Search Paths in the Category list on the left
ii) Click on the folder icon to add a folder
iii) Navigate to Hands-0On Exercises\MathScript\My Scripts and select

Current Folder

Y1 Server: Machine Access

WI Server: User Access

Search pathis) For .m files 7 B
WI Server: Exported Yis @ C\Documents and Setbingst AdministrakoriMy DocumentsiLabyIEW D

Conditional Disable Symbols
MathScripk: Search Paths *—H— -1

iv) Click OK to close the properties window
V) Right click on Dependencies and select Refresh

vi) LabVIEW will now list add2num.m under dependencies

2) Eliminating syntactical errors from MathScript Test.vi
a) Now that the .m file is added to our Search path, add2num.m should be a recognized.
However, the run arrow is still broken because LabVIEW has detected another error, and
LabVIEW will list all errors within the VI if you attempt to run it.
b) Click on the run arrow to display the error. Although there are no problems within the

script node, the error tells us that our UDF, add2num.m, contains a syntax error.

Note: Prior to LabVIEW 8.5, we would not be able to debug UDFs in this manner.
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3)

30

Open add2num.m in the MathScript window
a) Open the MathScript window by clicking Tools >> MathScript Window...
b) Click on the Script tab

c) Click on the folder icon and select the add2num.m file in order to open and edit it

_ \-'ariables.l Script I__HiStUW
1']}] CiADocurms
_—

unction © = addZnumia,b)

temp=0;
r=(a + b+)/temp;

d) Note the syntactical error on the fourth line. Delete the unnecessary ‘+’ character.

e) Save the file by clicking on the disk icon in the script window.

f) Overwrite the existing add2num.m file when prompted

g) Once the save is complete, return the front panel of MathScript Test.vi and note
that you can now run the VI

h) Click the run arrow to run MathScript Test.vi

i) Two of the graphs are displaying incorrect data. In part two we will use new debugging

tools to find the source of our erroneous computation.

B} MS Test.vi Front Panel on 8.5 Version. lvproj/My Computer ™
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lE‘ | 13pt Application Font |« H:Dv ”'.u“'-v “ﬁv ]
-
Low frequency companent 4 Plat 0 “__ High Frequency component Plat 0 “_
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00918367 ~ Hnput signal _ Plato |~ Cutput signal Ploto A%
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Part 2: New Tools for Debugging MathScript Code

1) InPart 1, we successfully debugged syntactical errors within MathScript Test.vi
and we are now able to run the VI. However, the data appears to have a problem caused by
incorrect code, which we will need to isolate and resolve. With LabVIEW 8.5, we can probe
the MathScript Node and see intermittent values of the variables defined within the node.
a) Right-click the border of the MathScript Node on the block diagram of MathScript
Test.vi, and select Probe.

b) The LabVIEW MathScript Probe window will appear

c) Return to the front panel of the VI and click the run arrow.

d) Observe that the MathScript Probe window is being populated with variables and their
values.

e) Click the STOP button on the front panel of the VI.

B LabVIEW MathScript Probe

Variables | output
[ I.:‘artition,l'\l;ariélslé Dimension Twpe d\
=] Mathscripk Mode I
fhigh 1x1 double array
Flow 1xl double array
1 1xl double array
n 1x101 double array
num 1x5 double array
s1 1x101 double array
1x101 double array
§ 1x101 double array
¥ 1x101 double array
o |
[ araphical first ;'Numeric w
¥ [1, 101]
# T T i
go |w |Inf [Inf |
!-"
o0
j 0 0 i}
0 o i
o o 1]
0 1] 1]
] ] ]
1] 1] 1]
o 1 0 i
£ >
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f) Double click on x and observe that all values are infinite
g) Double click ony and observe that all values are not a number (NaN)

2) Identifying the reason for the incorrect values
a) The x variable is set by the returned value of the add2num.m function, which
indicates that there is a mistake within this UDF.

b) Return to the LabVIEW MathScript window and examine how the returned value is set

c) cis infinite since it is divided by the value of temp, which is set to 0.

I add2num.m - Motepad E@E|

File Edik Faormat  Wiew Help
function ¢ = addznumfa, b))

c=ta + h)/temp;

d) Resolve this issue by changing the value of temp to 1
e) Run the VI and observe that the data is correct and that the program is working

B MS Test.vi

File Edit “ew Project Operate Tools Window Help
»
Low Frequency companent Plot 0 “ High frequency component
ket 1-
Desired Length e i
of Filter 3 ]
~ = =
5 £ El a = a
. < <
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flow
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0 0.5 Time: Time
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End of Exercise 4
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Additional Information

Visit ni.com/labview/upgrade to

e Learn about new features in LabVIEW 8.5

e View the upgrade notes

e Review Bug Fixes in LabVIEW 8.5

e Determine NI Software Compatible with LabVIEW 8.5
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http://zone.ni.com/devzone/cda/tut/p/id/6210
http://www.ni.com/support/lv8_5.htm
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